The Computer Industry’s Usability Catastrophe
Or, how the laptop makers and Microsoft have demolished my productivity
Some amazing things happened during 2007-2008 that most certainly have destroyed the productivity of millions of computer users, just as assuredly as the U.S. government’s creation of the subprime mortgage has destroyed the wealth of millions of homeowners and stockholders. But unlike the subprime mortgage debacle, almost nobody seems to be talking about the catastrophe in computer user interfaces. In fact I cannot find a single coherent article on the subject. So I thought I’d better write one.
Tyranny of the Shiny Widescreens
Somehow during 2007-2008, without a word being spoken about it, the entire laptop industry unilaterally decided to change the display characteristics of every laptop made. Never in the history of any product line of any sort have I seen such a complete disappearance of the old and the absolute inescapability of the new in such a short time. I speak, of course, of the introduction of the shiny, wide-screen laptop display.
Squinty Hardware
Prior to 2007 there was basically only one type of laptop screen. It had a matte surface and a 4:3 aspect ratio. It was the XGA standard, and it was almost the only thing you could buy. It was well suited to business applications for two reasons:
The screen was matte, so it would not reflect ceiling lights, windows, and the image of the user back into the user’s face. In other words, you saw what was being displayed on the screen, not what was in the room with you.

The screen was relatively tall, just like office documents. The American standard size of a business letter is 8.5” by 11”, which is an approximate aspect ratio of 3:4. So for modeling  a piece of paper, even the old XGA standard (4:3) was somewhat backwards, but not extremely so, and one could argue that there were other common applications (such as the spreadsheet) for which a screen that was wider than it is tall was at least in some cases preferable.
Coming into 2009, though, the XGA standard seems to have disappeared completely, and I do mean really completely. In numerous Internet searches, I have been unable to find even one laptop made by any maker anywhere that is not by default both widescreen and shiny, and there is apparently no laptop made today that is not a widescreen.
The widescreen aspect ratio is much more severely “landscape” than the old XGA standard. XGA was 4:3, but widescreen is 16:9, which is getting pretty close to 16:8 which is 2:1, or in other words we are now dealing with screens that are almost twice as wide as they are tall.
There are several nasty consequences of this new standard. For example a lot of people are under the false impression that a WXGA (widescreen) has a larger surface area than a comparable XGA screen because it has the word “wide” in its name. Unfortunately quite the opposite is true. Screens are advertised according to their diagonal lengths:
	
	

	XGA (4:3) with a 15.4” diagonal
	WXGA (16:9) with a 15.4” diagonal



The smallness of the “widescreen” becomes pretty obvious when we place the two models, each with the same advertised diagonal screen width (shown to scale here), next to each other. Does the widescreen look bigger to you? 
To confirm this more precisely, the XGA screen with a 15.4” diagonal has a surface area of about 114 square inches, whereas the WXGA screen with the same advertised diagonal has a surface area of about 101 square inches. So any given “wide screen” display of an advertised diagonal size will have only about 8/9 (or about 89%) of the surface area of an XGA screen having the same advertised diagonal.
Right away as a typical computer user you are losing by using a wide-screen. Unless you are using your laptop to watch movies that are perfectly suited to the widescreen format, you are displaying about 11% less stuff on a wide-screen of the same advertised diagonal size, for which you are paying the same amount as you would have paid for an XGA screen.
Is 11% significant? You bet. Millions of computer users are baby boomers whose eyesight is deteriorating with every passing day. A boomer with a widescreen has 11% less space to display the same fonts, which means that he or she must either be zooming up and consequently looking at 11% less content if the zoom is perfectly compensating or more if it isn’t, or struggling to look at characters that are 11% smaller than they would be on a comparable XGA machine. And of course the people immediately following the boomers will soon be sharing the boomers’ fate. How much lost productivity is that every day worldwide? It’s hard to imagine.
The Shining
I’m really not going to talk much about this one. All you need to do to understand the nastiness of the shiny laptop screen is to walk into any big-box store that sells laptops and look down a row of its shiny new offerings. What you’ll see primarily in every single one of them is the reflection of the store’s ceiling lights. The level of drug use in the upper echelons of the laptop makers’ top management must be simply beyond my imagination, since I cannot fathom what else could conceivably have caused them all to decide unilaterally that this was somehow a good idea.
A friend of mine put it perfectly. The only practical use for this new generation of laptops, he said, is for watching movies in the dark.
Squinty Software
The reduction of vertical space in a wide-screen laptop is even more severe than the reduction of total surface area. While the total wide-screen surface area is reduced by 11%, the vertical space is reduced by 25%. Or to put it another way, a wide-screen laptop has only three quarters of the height of an XGA laptop having the same advertised diagonal.  This is a pretty astounding difference; when viewing a portrait-style document (such as an ordinary business document) at the same resolution, you’ll be seeing only 75% as much of it as you formerly saw with your trusty XGA. Or alternatively, you’ll have to bump your wide-screen resolution up by 33%, making everything 33% smaller, to see the same amount of document.
As if to maliciously make matters worse, software makers and particularly Microsoft apparently decided during this same time to introduce software that would further restrict the vertical visibility of your user content. This happened in two areas.
First, everyone wanting to jump into the online-search business decided to launch an almost unavoidably self-installing “tool bar” for your browser. So in addition to the Google toolbar that made the concept of the browser toolbar basically indispensable, we now also have the Yahoo tool bar and the AOL toolbar along with a toolbar accompanying perhaps half of all the software packages you might install. In corporate environments where there are presumably even more sophisticated computer users than among the general population I have seen people with four or five toolbars installed on their Internet Explorers, without the foggiest notion of how to make all these toolbars disappear. Here is an image courtesy of Hanlon Creative, and it’s not even on a widescreen):



This illustration really kind of says it all. If this were on a wide-screen, you wouldn’t see any of the actual web page, since the 25% of the screen on which it is displayed simply wouldn’t be there.
As if to avoid being outdone by the toolbar makers, Microsoft has of course created its own MSN and Bing toolbars, both of which it will most enthusiastically install onto your browser unless you great care to uncheck the “toolbar” options when downloading and installing things.
The software nightmare you can’t wake up from
As if all this lunacy weren’t enough, Microsoft has gone even further by basically demolishing the formerly rational menu-based user interface it had spent years developing, and with the introduction of Office 2007 it has left us with only one option for getting our work done, namely the dreaded ribbon.
Ribbon Lunacy
The most immediately obvious disadvantage of Microsoft’s Office 2007 ribbon is the amount of vertical real estate it consumes an on already-diminished wide screen format. Compare the space available for your document in these two side-by side images of Office 2003 on an XGA screen versus Office 2007 on a WXGA screen (these are proportionately scaled so that the ratio you see here is approximately the real ratio):
	
	

	Word 2003 on XGA
	Word 2007 on WXGA



Without getting into the numbers, it is patently obvious just looking here that Microsoft’s ribbon, when used in conjunction with the marvelously inescapable wide-screen standard, places a lot less value on your content. Check out the number of lines you can see on the exact same document being shown here at the same resolution using the two different generations of combined hardware and software.
But enough about screen space. I think we’ve belabored this to the point enough, especially in view of the fact that the effect of the ribbon is far more destructive than the simple loss of pixels in which to display your content.
The ribbon is dramatically reducing productivity by making it almost impossible to find the features that you need to get your job done. Prior to the ribbon, we had a really nice arrangement called MENUS. Menus were based on a really intelligent idea: namely that people can more efficiently search for things if they can approach the desired target by zeroing in on it gradually, searching through only a few options at a time.
The typical application has hundreds of functions that a user might engage. If these were merely presented as one huge group, it would take enormous amounts of tedious searching to find anything. As an example, let’s consider a word processor. Formerly we had Microsoft Word 2003, which had menus like this:
File
New
Open
Close
Save 
…
Edit
Undo
Repeat
Cut
Copy
…
View
…
Notice the purpose here: at each menu level there was only a handful of sub-things to look at. If you found that you were gradually approaching your objective, you could move down to the next level and see only perhaps four or five things. If you found yourself walking down the wrong path, you’d back up and once again be looking at only a handful of alternatives. The idea was to prevent you from getting a headache by tediously having to look through dozens of things at once.
Menus were also compact. When you weren’t using them, they took up almost no screen space.
Of course a menu is only as good as its design. If topics at any given level don’t make sense, or if the children of a topic don’t seem to be logical subdivisions of that topic, then the menu can’t help you much. Microsoft was never particularly good at designing logical menus, but at least the potential for efficiency was there and even occasionally realized. But even with a lousy menu design you were still ahead of the game, because at least you could be assured that your solution would almost certainly lie under one of the finite and easily located menu items. 
If you did happen to have a bunch of related useful things that you wanted to see constantly, then we “had an app for that”. It was called a toolbar:

Like menus, toolbars were small. If you liked having a lot of them you could have many.  If you hated them you could have zero. If you wanted only one you could have just the one. And you could customize toolbars by adding or removing icons.  In short, like at Burger King, toolbars let you have things your way. But what we have with the ribbon instead is this:

The ribbon is basically a set of tabbed toolbars on steroids with a first-level menu on top (i.e. in the tabs). A ribbon is huge, taking up the vertical space of the old menu plus about three toolbars, and its width is the entire window. None of this is customizable. It’s take it all or leave it.
Instead of the four or six items to grasp at once in a menu, or even the 10 or 15 items to scan on the optional toolbar, this default ribbon page has 40 items for you to take in all at once. Yes they are sub-grouped (at the bottom) but it’s still 40 items to look through if you happen to think your desired action might be on this page. And few ribbon pages are lumped into as few related categories as this one.
So let’s compare the efficiency of the old menu to the new ribbon. For example suppose we’ve made a table and now want to change its border styles. Here’s how we do it in Word 2003:
	
	

	



This is a fairly straightforward three-step process, though not what we’d call 100% intuitive. We drop down the Table menu, select Table Properties, select Borders and Shading within the Table Properties dialog box, and select appropriate options from within the Borders and Shading dialog box.
Let’s repeat our table-border experiment using the ribbon. We have a table and we want to change its border. With the ribbon we start by picking …. what? Home? Insert? Page Layout? References? Mailings? Review? View? Well perhaps we might recall that we saw a Table icon on the Insert ribbon page, which is where you had to go to create the table in the first place. Which is logical I guess because you had to “insert” the table, just like you had to “insert” absolutely everything else that’s in the document. Got it? Right.
So let’s look at the Insert tab, even though we’re not inserting anything:

 If you start scanning from left to right you’ll find the large Table icon pretty quickly. But if you went from right to left you’d have scanned 20 items before finding Table. Not so bad though … so let’s click on Table and see what happens:
	
Hmmm … no promising leads here. Lessee maybe there’s something under Insert Table:
	
Nothing there. The other simple entries don’t look relevant. Let’s see what’s in Quick Tables:

Also useless.  It’s starting to look like we can’t get to the table border functions from anywhere under the huge Table icon. Isn’t that clever? So what would we do next logically? I guess I’d start looking on the other ribbon pages to see if other pages seemed to have table-related items on them. Leafing through all of them:	
[image: ]
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[image: ]
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[image: ]
Why would I look through all the ribbons instead of just the few with more promising names? Because my original failure was so preposterous. There used to be a “Table” menu item under which I could find everything table-related. Now I found something here that looks like it should perform the same function, but it does not. If I cannot find table-related things under the huge “Table” icon, then why should I expect any rhyme or reason to the rest of the ribbon layout? And furthermore, none of the available options makes any more sense than the other anyway.
Hmmm. So my search only required looking through one or two hundred icons. Still no luck. OK I guess we can’t get to this function from the ribbon at all.
At this point we’d better realize that the ribbon is context sensitive, so it is not going to allow us to do this at all unless we’ve selected a table. So we select the table and … viola! The ribbon’s menu changes. Now we have a new Layout tab that looks pretty hopeful. Let’s go in there:	[image: ]
Great. Now we only have to look through 31 icons before we determine that this ribbon also isn’t going to let us change the table border. Oh well that’s OK, because two of the five subgroups have their own dropdown menus: Rows & Columns and Cell Size. Rows & Columns sounds more promising, so let’s go there:
	[image: ]
Nope.  In an act of desperation, let’s try Cell Size, which has nothing to do with borders, but by this point we’re ready to try anything. Aha! Finally we see the familiar Table Properties tabs that we could have gotten to in three logical steps in Word 2003:

Of course we could have done better. We might also have chosen the Design tab, which also appeared when we clicked on or in the table:	
 After searching uselessly through the 19 irrelevant icons on this tab, we might have noticed that in the very bottom right is a grouping title called Draw Borders with a sub menu, and when we open that, we also get to our destination.
This is not an isolated freak incident. This is how I spend much of my time using Word 2007. Geez. What an improvement. Thanks Microsoft!
Scatterbrains Rule: Death by Crazy-Quilt Menu
The user interface guys at Microsoft must have stayed up nights dreaming up the ribbon, but that wasn’t enough. My guess is that Microsoft’s ribbon people didn’t have time to put ribbons on absolutely everything, so what they did for the products that don’t have ribbons yet was to simply deconstruct the menus.
Yes, in its newfound menu hatred, the Microsoft’s user-interface guys went around, apparently having nothing better to do, and broke up the menus from their former unified location (near the top of your screen) and simply scattered their components around the screen.  Really, I simply cannot imagine any motivation for doing this other than a malevolent desire to disable users.
Let’s look at a popular example. As of IE8, Microsoft hasn’t yet inflicted the ribbon on Internet Explorer, so as a stopgap it took the components of the menu and scattered them about the screen. Here’s an image of IE8 displaying a blank page (with Google toolbar installed and Google as the default search engine):

Note that the menu has simply disappeared entirely. This is a sort of brilliant idea, really. I mean, why have a menu when you’re not even displaying a page? Unfortunately the logic is a bit faulty. What, for example, do I do if I want to know what version of IE this is? Well for my convenience and in its zealousness to protect me from the tyranny of the menu Microsoft has removed my ability to investigate that. I have to display a page, it seems, in order to discover what version of IE I’m running.
OK so let’s load a page and see if we can get access to any of our formerly obvious menu functions:
[image: ]
Huh. Still no menu. What do I do? Where do I go? Apparently Microsoft thinks I have lots of time to spend on things like this. What once took seconds will now apparently take minutes.
Note that this is not even similar to the ribbon dilemma. With the ribbon, you could argue that I am a curmudgeon that was comfortable with the old ways and just can’t get used to the new ways. But here there isn’t even a “new  way” at all … unless I can find it, that is.
Where did they hide the menu? Mmmmm mmmm let’s see. I guess I’ll just start clicking all over the place, even on things that I wouldn’t expect to produce a menu, because this is so insane and so anything I try couldn’t possibly be more idiotic than the situation in which I have already been placed. Maybe there is a menu option somewhere that lets me elect to have my old menus back … but ha ha the joke is on me, because of course I can’t get to the menu to set it!
Finally, by random chance, I decide to right-click on the white-space to the right of the tabs. I do this because in my weeks of struggling with the new world of Microsoft 2007 design, I have learned that context menus (which they haven’t eliminated yet) are often my only hope for getting anything done, ironically because they are the same menus that used to exist under the menu bar (if only I could figure out when they’re available):
[image: ]
Ah. “Menu Bar”  This looks promising. Realize, of course, that in doing this I am hoping for nothing more than a return of what was taken away from me. I am hoping for nothing better than to make things as good as they used to be. So I turn on the “Menu Bar” and I get:

Presto! My old-fashioned menu back. And I only wasted 15 minutes finding it!
This would all be a little less scary if my IE example above were the worst one, but it isn’t. I distinctly remember some recent versions of IE (6 or 7) in which the menu simply wasn’t available, and pieces of the menu’s functionality could be found only under various icons scattered throughout the user interface.
Other vendors are now blindly following Microsoft’s imbecilic lead. I download a new version of a formerly comfortable tool (for example SnagIt, the screen-capture tool that I used in producing this document) only to discover that the latest version is now a confusing quagmire of ribbons and crazy-quilt menus, and that operations that I formerly accomplished in seconds now take minutes.
I talk to seemingly intelligent comrades of mine and they vaguely acknowledge all of these time-draining annoyances one by one, but only after I bring them up. Yes they noticed all of them, they confide, but somehow they have managed to quietly adapt to Microsoft’s brave new world without so much as a peep of protest. Where will it all end?
The End Indeed … of my Productivity
I am a consultant. It’s a typical day for me on-site at a typical client’s office, I sit before my client-supplied laptop, suffering from eye fatigue induced by my forcing my eyes to refrain from focusing on the brilliant reflected images of the ceiling lights on my screen. All day I squint to see the tiny type that my WXGA screen displays in its reduced overall space and in its even more severely reduced vertical space. Finally succumbing to eye strain, I bump up the zoom on the document I’m reading to the point where I can see the characters without permanently furrowing my brow, but I see so little of the page that I have to actually print the thing in order to get a sense of what it will look like.
I seek to do one interesting thing that I haven’t done before in Office 2007, and I am immediately plunged into a sort of bad dream in which I struggle pointlessly to find the feature I need (made worse by my fading mental image of exactly how I would have done it in Office 2003). After minutes of almost random futility in searching through the terribly organized ribbon icons, I finally find the feature, usually by luckily clicking for a context menu on the right place (thereby producing the same menu I used to find easily). Almost invariably the feature has most of its options set to defaults that I dislike, so I spend more minutes figuring out how to reconfigure its options using the new option layouts. After a half an hour I have perhaps managed to do what I formerly did in five minutes.
It amazes me when even Apple, which is not your company to typically follow other industry titans on a suicide march, has joined in the wide-screen tyranny and no longer offers even a single XGA model. I am trying to imagine the meeting in which 100% of all laptop makers worldwide convened to decide that XGA would disappear of the face of the planet, and that all of them, marching in unprecedented lockstep, would offer nothing but shiny, productivity-destroying wide-screens. It’s hard to get my mind around it. And yet, despite this totalitarian elimination of something that had been a favored industry standard for decades, there is nary a peep in the press or even in the blogs.
Every once in awhile, it seems that an entire industry loses its mind and universally adopts terrible ideas which it then inflicts upon the rest of us. This happened in the education industry starting in the 1930s, when a band of delusional education-school professors decided that teaching phonics was a bad idea (this is somewhat comparable to people in the automotive industry suddenly deciding that wheels are a bad idea). Somehow this band of professors managed to cow the entire ed-world into buying their lunacy, and today we are still suffering the effects of a fanatical, frothing-at-the-mouth educational policy that has left generations of children in the dust, fundamentally incapable of reading at anything beyond a child’s level. You would think that something like this would have the nation literally up in arms, shutting down teachers’ colleges en masse and removing incompetent teachers immediately from classrooms before another day’s worth of damage can be done. But no, almost nobody talks about it, except a small minority of perplexed parents who wring their hands and puzzle at how our students could be doing so poorly on every annual reading test.
I am convinced that something similar is afoot in computing. Computers and software were moving dramatically forward from the 1940s into somewhere around the mid-1980s, with powerful, compact, advanced multi-user operating systems like UNIX and object-oriented programming becoming the norm. Then suddenly all of corporate America decided that computers belong on a desktop, and we were whisked back into the computing stone age with the universal adoption of “operating systems” like CP/M and MS-DOS. We have only recently crawled back out of this muck and resumed our upward trajectory, picking up at about the same place software-wise that we were perhaps 30 years ago, having decided once again (with “netbooks” and “cloud computing” now all the rage) that computers really do not belong on desktops and that we would have been better off all along using big centralized machines running real operating systems. But now this.
Oh well. The march of the lemmings goes on ...
Summary
Wide-screens suck.
Shiny screens suck.
Ribbons suck.
Crazy-quilt menus suck.
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